Galion Public Library

Introduction to Word Processing class handout

Basic Word Processing

There are many things you can do with word processing - letters, resumes, research papers,

signs, class handouts, ...

but the important thing about word processing is that you are creating

something that you will print out on paper. Many computer applications are not intended for

printing things out on paper. For example, most
web pages are not really designed to be printed,
and they may not come out looking quite like
you envisaged - and that's okay, really, because
looking good on paper is not the purpose of a
web page. Making things look good on paper is
the purpose of word processing.

Because word processing has been around for a
long time, many of its common features are
standardized - they work the same way, pretty
much no matter what software you use. Thus,
most of the word processing skills that you learn
using OpenOffice will still work if you switch to
WordPerfect, MS Works, or something else.

The Cursor & the Pointer:

On a word processing screen, there are two key
points of interest: the cursor and the mouse
pointer (sometimes called the mouse cursor or
the pointer). The cursor relates to the keyboard
as the pointer relates to the mouse: whatever
you do with the mouse buttons takes place

What is Desktop Publishing?

Desktop publishing has the same basic purpose
as word processing: to make things look good
on paper. Historically, the difference between
the two applications has been one of degree:
word processing was simple, and professionals
who needed to do more complicated things used
desktop publishing. Over the years, though,
word processing applications have gained more
and more of the features of desktop publishing,
so that there are fewer and fewer differences.
Features that originated in desktop publishing
and are common in word processing today
include scalable fonts, frames, columns,

expanded and condensed fonts, the ability to
have text wrap around the contoured edge of an
image, and the ability to export formats that
printing shops can use, such as Postscript and
PDF. Desktop publishing applications do still
have some extra features, like the ability to
rotate objects at any angle.

where the pointer is pointing, but things that you type on the keyboard happen wherever the
cursor is. In word processing, there are two ways to move the cursor: by using the cursor-

movement keys on the keyboard, or by pointing to the location where you want the cursor to go
and clicking; the cursor will jump straight to where you clicked.

Whatever you do with the keyboard takes place where the cursor is. For example, if you use the
backspace key on the keyboard to erase, it erases the character right before the cursor.

Word Wrap:

The word processing software knows how a paragraph should be shaped. It knows how to move
words down to the next line, or back up to the previous line, to make the paragraph look right.
Rather than manually moving the words around every time you make a change, let the word
processing software do it for you — but how does the software know where one paragraph ends
and the next begins? For this there is a special character, called a paragraph break.

Characters:

A character is a single piece of text in a word processing document: a letter, a numeric digit, a
punctuation mark... what trips most people up is that a few special characters are not directly
visible (although their effects are visible). The most common of these invisible characters are
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the space, the tab character, and the paragraph break, which are inserted with the spacebar, the
tab key, and the return or enter key, respectively. (There are others too, such as column breaks
and hard page breaks.) These characters, although not directly visible, are still characters that
are present in the text, and may be erased just like any other: put the cursor right after the
character, and hit the backspace key. So, to separate a paragraph into two paragraphs, position
the cursor where you want the break and press the enter or return key. To combine two
adjacent paragraphs into one, place the cursor after the break - j.e., at the beginning of the
second paragraph - and tap the backspace key.

Commands:

Typing in text is a great start at a document,
but sooner or later you're going to want to do
something more interesting with it. All the
different things the software knows how to
do are called commands, and you can get to
them through the menu, toolbars, or special
key combinations called shortcuts. All of the
available commands are available in the
menus; the toolbars and shortcuts are just
another way (perhaps a more convenient
way) to reach the most common ones.

We'll start with the menus: across the top of
any word processing window, just below the
title bar, is a menubar, containing several
menus: File, Edit, ..., Help. If you click any
of these, it will drop down an entire menu of
choices - these are the commands, the
things the software can do for you. To the
right, the shortcut key (if any) will be listed
for each one. For commands that you use
frequently, you may choose to learn the
shortcut, so that you don't have to take your
hand off the keyboard and mess with the
mouse each time you need to do that thing.

Selecting Text:

Dragging

Dragging is when you hold the
mouse button down while
moving the mouse. To select text
by dragging, point to the

beginning of what you want to
select, press and hold the mouse
button, move the mouse to the
end of what you want to select,
and then release the button.

changes.

Important Commands

Here are some of the most useful commands:

- Save — Found under the File menu, the Save
command commits any changes you have made to
disk, making them permanent. If the document is
new (i.e., has not been saved before), Save will
automatically do Save As instead. Remember:
Save early and save often!

+ Save As — Instead of committing just your
changes to an existing document, Save As will
save a new copy of the whole document,
prompting you for a new filename to save under.
The previously-saved version of the document
will not be disturbed.

- Open — This command allows you to revisit a
document that you have saved previously, so that
you can make further changes, print another
copy, or whatever.

- Undo — This lifesaver will allow you to revert the
most recent changes that you have made. (Of
course, you can always discard your changes and
open the last saved version, but Undo is a less
drastic way to quickly recover small mistakes.)

In a word processing program, there are two ways to select
text: you can use the cursor-control keys on the keyboard
while holding the shift key down, or you can drag over the
text with the mouse. Either way, the text you select will
become highlighted, and then you can do things with it. For
example, you can delete it, format it a certain way (bold,
perhaps, or underlined, or with a different font face or size),
or you can cut or copy it to the clipboard - but to do any of
these things, you have to select the text first. The text that
you have selected is the text that will be affected by the
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Formatting Text:

In addition to the actual text itself, a word processing document may also contain formatting
information. (This sets word processing apart from typing with a typewriter or text editor.) The
text may be formatted to appear underlined or in italic or boldface, expanded or condensed,

larger or smalier, in a different FONT face or [EJISl, and so on and so forth. There are

usually toolbar icons for the most common types of formatting, but you can find all of them
under the menus. In the OpenOffice.org software, pull down the Format menu and select
Character, and a dialog box will appear offering all these options. Other word processing
programs may put the menu item in a slightly different place, but the option will be there,
somewhere.

Formatting Paragraphs:

Each paragraph can have certain
formatting settings associated with
it. Different word processing

The Clipboard: software may support different
= options (such as borders around
Before word processing was commonplace, people the paragraph or a background
used creative means to avoid retyping pages. color), but the most important
Sometimes they would take scissors and Scotch™ ones are margins and tab stops.
tape to a page they had typed, rearrange the These can be set in the paragraph
pieces, and use a photocopier to make a clean formatting dialog found under the
copy of the result. The computer's clipboard menus, but the ruler bar is easier.
works on similar principles. These commands are By selecting several paragraphs at
found under the Edit menu: once, you can change their settings
. ) together.

The Cut command is like the scissors. It

removes the selected thing from the Paragraph Margins control where

document - and places it on the clipboard. the word wrap feature shapes the

The Copy command is a less destructive paragraph. You can make a

version of the same thing. Rather than paragraph narrower or wider than

removing the selected thing from your the ones above or below it by

document, it makes a copy, and places the changing its margins. The right

copy on the clipboard. margin is the simplest: on the

i i ruler bar, near the right, you will
The Paste command is your ScotchTM_tape: it find a handle (often triangular) for
inserts the contents of the clipboard into your the right margin. If you drag it to

document, wherever the cursor is located. So,
click to place the cursor where you want it to

go, and then paste. Drag it back to the right, and your
paragraph will be wider.

the left, your paragraph will rewrap
at the new, narrower margin.

The clipboard can only hold one thing at a time.
When you cut or copy something new onto the Near the left of the ruler bar you
clipboard, its previous contents are gone. will see two handles for the left
margin. The lower one is the main
left margin handle, and works
similarly to the right margin but for
(most of) the left edge of the
paragraph.
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However, the top handle, above the main left margin handle, is called the indent handle, and it
controls the indentation of the top line of the paragraph only. By moving this handle to the
right, you can cause the first line of the paragraph to be indented. Going the other direction, if
you move the main left margin in a bit and then move the indent handle to the left of it, you can
create a situation known as a hanging indent (or outdent), wherein the top line of the paragraph
starts further left than the rest of the lines. (Hanging indents are commonly used for resumes
and bibliographies, among other things.)

Tab Stops:

Ancient mechanical devices known as "typewriters", which were used by primitive cultures
during the late pre-silicon era, used a metal tab to stop the advancing carriage when the tab key
was pressed. This was called a tab stop. Today, we have something very similar. Rather than
metal tabs, we now use paragraph settings, which can be conveniently set on the ruler bar.

If you click on the ruler bar, a tab stop marker will appear there. This new tab stop applies to
the current paragraph where the cursor is (or whatever paragraphs you have selected). Now
any tab characters within that paragraph will cause the following text to line up at that tab stop.
This is the best way to get things to line up, because they will line up exactly. (Lining things up
using spaces is prone to be off a little, because not all characters are the same width. Using
tabs will give you much better results.)

Once you have placed a tab stop, you can move it by dragging it from one location on the ruler
bar to another. To remove a tab stop, drag it off the ruler bar and drop it anywhere.

Types of Tab Stops:

T T T T T T - B oo B e 7o
§ | ke -l oA 4 Z
There are four types of tab stops: left, center, right, and decimal. Usually there is a button
somewhere near the ruler bar that you [ can click to change which type of tab stop you are

placing. The appearance of this button L | also will change to depict the type of stop.
Whichever type of stop you select on this button is the type that will be added when you click
the ruler bar. The ruler bar shown above has a left tab stop at one inch, a center tab stop at two
and a half inches, a right tab stop at five inches, and a decimal tab stop at six and a half, the
same settings used for the following lines:

Left Center Right Decimal

tab stops tab stops tab stops 42

align align align 512

at the along the at the 12.5

left edge center line right edge 3.14
like this. like this. like this. 2.71828

Sometimes you will want to change the margin or tab stops for the entire document at once. For
this reason there is a shortcut for selecting all the paragraphs in the entire document: under the
Edit menu, choose Select All. Then any changes you make will affect the whole document.

Print Preview:

Most word processing software offers a print preview or page preview that will show you what
the document will look like on paper. Sometimes you can save ink by using this preview to
catch changes you want to make before you print.
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File Formats:

Whenever you save anything on your computer, the software uses a specific file format designed
to store the kind of information you are saving. The file format tells the software how to
represent the information you see on the screen as a series of humbers that the computer can
store. For example, if you draw a picture and save it, it will be saved in an image file format,
but if you save a word processing document, it will be saved in a word processing file format.

There are many different file formats for word processing documents, because each word
processing program has its own format. OpenOffice.org uses ODF. Microsoft Word uses either
Word Format (DOC) or OOXML (DOCX), depending on what version of Word you have. Word
Perfect uses Word Perfect document format. Even different programs by the same vendor may
use different formats: Microsoft Word uses Word format, but Microsoft Works uses its own,
different format. Before ODF, old versions of OpenOffice.org used StarOffice XML Format.

Why does this matter? If you only ever want to open your documents on the same computer
you created them on, there's no problem. But if you want to open them on a different computer,
you may find that it does not have the same software installed.

The different word processing programs make some effort to support each other's formats, up to
a point, but none of them support every format. OpenOffice.org can open Microsoft Word
documents, for instance, but it does not support Microsoft Works format. For that matter, even
Microsoft Word does not support Works format. So if you take your document to a computer
that does not have the same software... you may find that you cannot open it.

The only solution is to use Save As to save the document in a different format that the other
computer will be able to open. For example, if you create a document on your home computer
using Microsoft Works, and you want to bring it to the library (where we don't have Works) to
print it, you can use Save As. Microsoft Works knows how to save in Microsoft Word format,
which is one of the formats that our software at the library does support. So, when you do your
Save As, look at the options for "file type" or "file format", and pick one that the software on the
other computer will be able to handle.

No format is universally supported, but if you don't know in advance what format you'll need,
Microsoft Word format is usually a good bet. Most word processing software can open files in
Word format.
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